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CE Mandated Warnings

VAN

Please read the following instructions carefully to prevent potential shock or fire hazards. This manual should

be retained for future use.
A\ A

Bitte lesen Sie die nachstehende Anleitung sorgfaltig durch um Stromschlag und Feuergefahr zu vermeiden.
Diese Betriebsanleitung sollte fiir spateren Gebrauch sorgfaltig aufbewahrt werden.

A\ A\

Preghiamo di leggere accuratamente, le sequenti Instruzioni, per evitare Prossiomi Incendi e Correnti.

. A\ A\

Shock Hazard — Do Not Enter
Achtung Hochspannung — Nicht Beriihren
Attenzione Corrent-Forte — Prego non toccare

2. A\

The front panel’s switch is not the power disconnect device. The power cord should be removed after use.

Der Kippschalter an der Vorderseite unterbricht nicht die Stromzufiihrung. Das Stromkabel sollte nach
Gebrauch aus dem Gerét herausgezogen werden.

L’interutore nella parete frontale non blocca le Corrente. La Corrente viene.

3. A\

Never expose the unit to water or liquids. Avoid direct sun.

Bringe das Gerét nicht mit Wasser oder einer anderen Flissigkeiten in Berlihrung. Vermeide direkte
Sonneneinstrahlung.

Evitare contatto con acqua oppure liquidi Infiammabili al Macchineggio. Auche entrate di Sole.

: A\



Do not insert any objects into the unit.

Keinen Gegenstand in das Gerét einbringen.Do non inseriamo any obietta into gli unita.

A\

Das Gerét nicht in der Nahe einer offenen Flamme oder Hitze benutzen.

Non mettere ogetti dentro la Macchina.

Do not use near open flame or heat.

Non mettere la Macchina vicino a fuochi oppure Riscaldamenti.

A\

Das Gerdt darf nicht eingeschlossen oder blockiert werden.

The unit should never be enclosed or blocked.

La Macchina non chinderla per nessun motivo.

A\

Connect unit only to a properly measured supply. Use only three wire cord which is provided with the unit.

Schlielen Sie das Gerét nur an eine ordnungsgemass vermessene Stromsversorgung an. Verwende nur ein
dreiadriges Kabel, wie es auch mit dem Gerat ausgeliefert wird.

Montare solo con misura normata. Adoperando solo 3 cavi elettrici cosi come e fornita la Macchina.



Filmetrics, Inc. Software License Agreement

BY COMMENCING USE OF THIS PRODUCT YOU AGREE TO BECOME BOUND BY THE TERMS
AND CONDITIONS OF THIS AGREEMENT.

LICENSE

This license agreement (“license”) permits you to use one copy of FILMeasure (“Software”) on any single computer. The
Software is owned by Filmetrics, Inc. ("licensor") and is protected by United States copyright law and international treaty
provisions. Therefore, this software should be treated as any other copyrighted material except that you may either: (1) make
one copy of the Software for archival backup purposes, or (2) copy the Software to a single hard disk. If the Software is used
on a networked computer system where more than one computer can access the Software provisions must be made to insure
that the number of concurrently executing copies of the Software cannot exceed the number of licenses.

You may transfer the Software and all rights under this Agreement to another party together with a copy of this Agreement
if the other party agrees to accept the terms and conditions of this Agreement. If you transfer the Software, you must at the
same time either transfer all copies (including any prior versions) in any form to the same party or destroy any copies not
transferred.

RESTRICTIONS

You may not use, disclose, copy, modify, rent, lease, loan, resell, network or transfer the Software, or any copy,
modification or merged portion thereof, in whole or in part, except as expressly specified in this Agreement. You agree not
to decompile, reverse engineer, disassemble or otherwise reduce the Software to a human perceivable form.

SOURCE CODE
If source code to the Software was supplied to you, then you may modify and use that source code in place of the executable
version of the Software, but no further rights to distribution or use are granted.

TERM

This Agreement is effective until terminated. You may terminate it at any time by destroying the Software together with all
copies, modifications and merged portions in any form. This Agreement will immediately and automatically terminate
without notice if you fail to comply with any term or condition of this Agreement. You agree upon termination to promptly
destroy the Software together with all copies in any form.

GOVERNMENT LICENSEE

If you are acquiring the Software on behalf of any unit or agency of the United States Government, the following provisions
apply:

The Government acknowledges the licensor’s representation that the Software and its documentation were developed at
private expense and no part of them is in the public domain. The Government acknowledges the licensor’s representation
that the Software is “Restricted Computer Software” as that term is defined in Clause 52.227-19 of the Federal Acquisition
Regulations (FAR) and is “Commercial Computer Software” as that term is defined in Subpart 227.471 of the Department
of Defense Federal Acquisition Regulation Supplement (DFARS).

EXPORT LAW ASSURANCES

You acknowledge and agree that the Software is subject to restrictions and controls imposed by the United States Export
Administration Act (the “Act”) and the regulations thereunder. You agree and certify that neither the Software nor any direct
product thereof is being or will be acquired, shipped, transferred or re-exported, directly or indirectly, into any country
prohibited by the Act and the regulations thereunder or will be used for any purpose prohibited by the same.

GENERAL

This Agreement will be governed by the laws of the State of California. You acknowledge that you have read this
Agreement, understand it and agree to be bound by its terms and conditions. You further agree that it is the complete and
exclusive statement of the agreement between us which supersedes any proposal or prior agreement, oral or written, and any
other communications between us in relation to the subject matter of this Agreement.

Filmetrics, Inc. Limited Liability Statement

In no event will Filmetrics, Inc. be liable for any damages or expenses, including any lost profits, lost savings, or other
incidental or consequential damages arising or associated with the use of, misuse of, or inability to use its products.
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Chapter 1 Introduction

What is the F20 used for?

The Filmetrics F20 is used to measure the thickness and optical constants (n and k) of transparent and
semi-transparent thin films. Measured films must be optically smooth and between 100A and 50
microns thick. Commonly measured films include semiconductor process films such as oxides,
nitrides, resists, and polysilicon, optical coatings such as hardness and anti-reflection coatings, flat
panel display films such as polyimides, resist, and cell gaps, and the various coatings used in CD and
DVD manufacture. Films that can not be measured include very rough films and opaque films.

Who should read this manual?

Chapter 2 should be read by anyone setting up a system for the first time. First time users should
also familiarize themselves with the FILMeasure software by reading Chapter 3, and then learn how
to make measurements by following an example in Chapter 4. More detailed instructions on how to
perform various functions are found in Chapter 5. Those interested in operation details can read the
appendices, which provide background on measurement theory and hardware operation.



Chapter 2 Installation

The following steps assume that the F20 system, cables, and accessories have been unpacked and that
you have a Pentium-based (100 MHz or greater) computer with a Windows 95/98/NT operating
system and an available parallel port.

Step #1: Connect the F20 Spectrophotometer to the Computer

With the computer power off and the power cord to the F20 spectrophotometer unplugged,
connect the F20 to the parallel port of the computer with the supplied cable.

A\

Plug the F20 spectrophotometer into a 100-240 VAC ~ outlet with the supplied cable. Power to
the light source is controlled by the front panel switch.

Step #2: Connect power to the F20

Step #3: Install software

If a computer was not supplied with the system then the software needs to be installed. Using the
supplied installation disks, follow the instructions on Disk 1 of the installation disk to install the
software on the computer.

Step #4: Test software

From the “Start” menu on the taskbar, select “Programs” and then select “FILMeasure” to begin
program execution. If the program executes normally, proceed to step 5. If a “No Spectrometer
Detected” message is issued and the power cord and interface cable are connected correctly,
perform the following actions:

Perform the following actions only if the “No Spectrometer Detected” message is issued:

a) Restart the computer and enter the CMOS setup. For a desktop computer system this is
typically done by pressing the Delete key immediately after power up. For a notebook
computer the setup is often entered by pressing F2 or F10.

b) Find the part of the CMOS setup which deals with the parallel port (often this is found in a
section called “Integrated Peripherals” or “Chipset Features”). Change the mode of the
parallel port to ECP (other modes which may work are sometimes called SPP, BPP, EPP,



PS/2, or bi-directional). If there is an option dealing with whether the parallel port is
reconfigurable or locked, select locked. The parallel port I/O base address must be one of
the following: 378, 3BC, or 278. Save the changes and exit setup. Now try executing
FILMeasure again.

¢) If the “No Spectrometer Detected” message reappears, try changing to one of the other
modes listed above and executing FILMeasure again.

d) If the “No Spectrometer Detected” message still appears after trying the above listed
modes, the computer hardware is not compatible with the F20. If the computer is a desktop
PC a plug-in parallel port card should be added. Plug the parallel port card into an open
slot. After installing the parallel port card, try executing FILMeasure again.

e) If none of these steps helps, contact Filmetrics for assistance.

Step #5: Connect Fiber-Optic Cable to the F20

| FILMETRICS
LIghtSource N
Switch
n
O]

Light Source Output Spectrometer Input

Figure 2.1: F20 Spectrometer/Light Source front panel

Follow the instructions on the following pages for setting up your particular measurement hardware:



If using fixed (SS-1) or rotating (WS-8, WS-12) sample stage:

Connect the fiber-optic reflection probe between the F20 front panel (illustrated in Fig. 2.1) and
the stage as shown in Fig. 2.2. The reflection probe should be fully inserted into the arm on the
stage. The screw on the end of the stage arm is actually a spring-loaded ball plunger, and does

not require tightening.

100-240 VAC To Computer
50-60 Hz Parallel Port

>

Spectrometer/
Light Source Unit

Light Source Spectrometer
Output Input

[«— White Label

Fiber-Optic Cable
(2 meters)

Stage Arm
Spring-loaded
Set Screw

|

Sample

(face up)\

[
- -

Figure 2.2: Setup Configuration for stage.



If using Contact Probe (CP-NIR):

Connect the Contact Probe to the F20 front panel (illustrated in Fig. 2.1) as shown in Fig. 2.3.
The two fiber ends leading from the Contact Probe are identical, so they can each be attached to

either the light source or spectrometer.

100-240 VAC To Computer
50-60 Hz Parallel Port

~~

Spectrometer/
Light Source Unit

Light Source Spectrometer
Output Input

Contact Probe and
Fiber-Optic Cable
(2 meters)

Sample
\

Figure 2.3: Setup Configuration for Contact Probe.




If using Contact Stage (SS-1 with CS-1 option):

Connect the Fiber Optic Contact Probe to the F20 front panel (illustrated in Fig. 2.1) as shown in
Fig. 2.4. The two fiber ends leading from the Contact Probe are identical, so they can each be
attached to either the light source or spectrometer. Connect the four 3" legs to the bottom of the
SS-1 Sample Stage. Remove the tilted mirror insert in the SS-1 stage using a 1/16” hex socket
driver. Screw the Fiber Optic Contact Probe common end into the black contact adapter, and
then fully insert the contact adapter into the bottom hole in the SS-1 stage, fastening it with the
1/16” hex driver.

100-240 VAC To Computer
50-60 Hz Parallel Port

>

Spectrometer/
Light Source Unit

Light Source Spectrometer
Output Input

Fiber-Optic Cable
(2 meters)

Sample

(face down)\

3" legs

Figure 2.4: Setup Configuration for Contact Stage.



If using Transmission Option (SS-1 with T-1 option):

Connect the fiber-optic reflection probe between the F20 front panel (illustrated in Fig. 2.1) and
the stage as shown in Fig. 2.5. The reflection probe should be fully inserted into the arm on the
stage. The screw on the end of the stage arm is actually a spring-loaded ball plunger, and does
not require tightening. Connect the four 3” legs to the bottom of the SS-1 Sample Stage.
Remove the tilted mirror insert in the SS-1 stage using a 1/16” hex socket driver. Screw one end
of the single fiber optic cable into the black adapter, and then fully insert the adapter into the
bottom hole in the SS-1 stage, fastening it with the 1/16” hex driver. Before taking a baseline
measurement, be sure to set the mode of operation to transmission. See Section 4.2, Example #6
for more information on Transmission measurements.

100-240 VAC To Computer
50-60 Hz Parallel Port

Spectrometer/
Light Source Unit

Light Source Spectrometer
Output Input

White Label

Fiber-Optic Cable for
light source transmittance
(2 meters)

Fiber-Optic Cable
for transmission input
(2 meters)

Spring-loaded
Set Screw

|

Sample

Figure 2.5: Setup configuration for T-1 Transmission option.



If using Reduced Kinematic Mount with lens assembly (LA1-RKM):

Step #1: Connect Fiber-Optic Cable to the F20

Connect the fiber-optic reflection probe between the F20 front panel (illustrated in Fig. 2.1) and
the LA1-RKM as shown in Fig. 2.6. Slide the reflection probe part way into the lens assembly.
The spring-loaded setscrew should be adjusted so that the reflection probe is held in place, yet it
may be moved in and out for focus adjustments.

100240 WAL Tix o
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—

Figure 2.6: Setup configuration for LA1-RKM lens assembly.

Step #2: Adjust the lens assembly:

This step involves adjusting the focus and tilt of the lens assembly for maximum signal and
assumes that the lens assembly has been mounted on a fixture approximately 6 inches above the
sample surface, and the "read" return fiber from the lens assembly to be adjusted is connected to
the spectrometer input. The idea here is to adjust the tilt and focus for maximum signal. To do

this,
a) Turn on the light source with the front panel switch and start the FILMeasure program



b)

d)

9)
h)

Go to the "Data Acquisition™ dialog box under the "Set Up" menu. Set the integration
time for 100 milliseconds, and make sure "Subtract Dark™ and "Use Reference" are de-
selected.

Select "Start Continuous Acquire" under the "Acquisition™ menu.

The reflection probe contains 7 fibers — a single detection fiber surrounded by 6
illumination fibers. Do a rough focus adjustment by placing a diffuse surface (a business
card works well) at the sample position and then focus the light beam on the sample
position by sliding the reflection probe inside the lens tube. (The diffuse reflector will
allow you to see the beam.) When 6 individual spots can be seen, slide the reflection
probe farther into the LA1-RKM until the spots merge into the center of the illuminated
area.

Place a reflecting sample, such as a silicon wafer, on the sample stage, under the lens
assembly. You should now see a trace on the screen. Turn the tilt adjustment screws to
maximize the signal. If the signal saturates, reduce the integration time (see step b).

Optimize the focus to maximize the measured signal by adjusting the reflection probe
position in the lens assembly. Focus the light beam on the sample by sliding the
reflection probe inside the lens tube. To see the beam, it may be necessary to place a
diffuse surface, such as a business card, over the sample. Ideally, the best focus
adjustment is when the beam is just under focused. To achieve this, focus the beam on
the reflecting sample, and then move the reflection probe slightly down in the lens tube
until maximum signal is obtained. Always avoid the over-focus condition (see Figure
2.7). When finished, tighten the socket head set screw that secures the fiber. Once
again, if saturation occurs, it may be necessary to reduce the integration time.

Repeat steps e) and f) to make certain the adjustments are optimal.

The set up is now complete. Now select "Stop Continuous Acquire” under the
"Acquisition™ menu.
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Figure 2.7: Focus Control for LA1-RKM lens assembly.



How to Adjust Spot Size:

The reflection probe contains 7 fibers — a single detection fiber surrounded by 6 illumination
fibers. The measurement spot size is not the illuminated area, but rather the intersection of the
illuminated area with the projected image of the detection fiber. When focused for maximum
signal, the measurement spot size is roughly half the diameter of the illuminated area.
Adjustments to the fiber and sample locations according to the following equation affect the
focus of the measurement spot area.

1
+ ———
dl
where f is the focal length of the lens, fixed at 15 mm. d, is the distance between the lens and the

fiber, and d; is the distance between the lens and the sample.

By moving the fiber in the stage arm and/or adjusting the height of the sample, the measurement
spot size changes. If the sample is raised up off the stage surface 30-40 mm and focused for
maximum signal, the spot size is approximately 0.5 mm. An image of the measured spot can be
viewed by connecting the single fiber to the light source.
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Chapter 3 System Overview

The way that light reflects off of a thin film is determined by the characteristics of the film, such as
its thickness, optical constants, and roughness. The F20 is able to determine thin-film characteristics
by first carefully measuring the amount of light reflected from the thin film over a range of
wavelengths (i.e., by measuring the reflectance spectrum), and then analyzing this data by comparing
it to a series of calculated reflectance spectra. Most of the features of the FILMeasure software that
runs the F20 can be divided into reflectance acquisition and reflectance analysis functions. The
following pages outline the main features of the FILMeasure software.

11



10.
11.
12.
13.
14.
15.

FILMeasure Main Window

File Edit SetlUp Acquire “Window Help

1
Sample ID: [Ha1728 Opprater: [Cassandra H. F’
— Meazured Data
Cursor Wavelength(nm):' ' — Calculstion COCEEEE eI rrrrne
|

‘[ 7629 A <—

Baseline -
Measure |-€—
RedAnalyze -

Structure: ISiO2 on Si 'l b
Edit Structure. .. I *\

Reflectance

-

bdobde

Sio2= I 7629 &
Fitting Errar = | 0.003642

0 heazurement #: |1

¢

400 500 &0 oo 800 Show Table | Show Statistics |

wavelength(nm)

Standard Windows File menu for saving and retrieving data, printing, etc.

The Edit menu is used for copying measured spectra and measurement results, as well as
selecting thickness units and editing the material library.

Used to setup reflectance acquisition parameters and the graphic display.

For starting and stopping continuous reflectance acquisition. Convenient for setting up
hardware.

Graphical display for measured and calculated reflectance, as well as measured optical
constants. Change display limits by double-clicking in the display area. A click of the
right mouse button while the curser is within the graphical display activates a blue line
(one click for measured curve) and red line (2 clicks for calculated curve) for easy reading
of cursor values in the Main Window. Keyboard up/down and right/left arrows move the
line to a desired location.

The measured film thickness is displayed here.

The baseline measurement sequence, which is required before measurements are made, is
initiated by pressing the Baseline button.

This button causes a reflectance spectrum to be acquired and then analyzed in one step.

Analysis only on the displayed reflectance spectrum. Usually used when trying different
analysis settings on a previously acquired spectrum.

Used to select the film structure that is to be measured.

This is where the selected film structure is described, and the analysis parameters are set.
Used to select the information displayed in the Results Box below.

The Results Box summarizes the most recent measurement results.

Statistical tabulation of all measurement results are accessed by pushing this button.
Complete results of the most recent measurement are accessed by pushing this button.

12



Edit Structure Window
2 (3 (4)
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A structure defines the film to be measured, the substrate and any underlying films, the approximate
thickness of the film, and the quantities to be measured:

1. The name of the film structure is listed/edited here.

The structure can be saved as a new structure, deleted, or changes can be saved.

Advanced measurement parameters can be accessed by clicking on the Options tab.

Constraints on the possible measured values are selected here.

The number of film layers is chosen here.

The values to be measured are selected by checking the appropriate boxes.

A very robust thickness measurement routine is enabled by selecting this box.

Known film roughness for films not being measured, and the initial guess for the film(s)

being measured are entered in this column.

9. Known film thicknesses for films not being measured, and the initial guess for the film(s)
being measured are entered here.

10. All of the Edit Structure parameters can be copied, printed, imported or exported. This is
convenient for remembering temporary setups, setting up multiple F20s, or sending
measurement parameters to Filmetrics for troubleshooting.

11. The film layers are listed here. Common films can be selected from the pull-down menus.

© N gk wn
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Chapter 4 Making Measurements

4.1 Types of Measurements

Accurate measurements with the F20 rely on using the proper measurement setup. The type of setup
that is used depends upon whether both thickness and optical constants are being measured, or just
thickness alone. Also important are the thickness of the film and the type of substrate.

The basic steps for any F20 measurement are: 1) selecting and editing the type of film to be
measured, 2) taking a baseline measurement, and 3) clicking on the “Measure” button to make the
measurement. Each example below will take you through this sequence of steps. In each example it
is assumed that the hardware has been set up as described in Chapter 2, and that you have first read
through Chapter 3 to familiarize yourself with the basic controls. The Measurement Assumptions,
Hints, and Troubleshooting sections describe techniques that should be followed for the most
accurate measurements.

Examples that describe the most common measurement setups are described in this section. Use
Figure 4.1 to find the proper example for your application.

14



WHAT IS TO BE MEASURED

Thickness
and Optical
Constants

Thickness
Only

Is substrate transparent
with reflective backside?
(See note A)

Is layer to be measured
>1/2 um thick?

Is substrate transparent
with a reflective backside?
(See Note A)

Go to
Example
#1

Go to
Example
#4

Is substrate
>2 mm thick?

Go to
Example
#1

Go to
Example
#5

Is substrate
>2 mm thick?

Go to
Example
#2

Go to
Example
#3

Note A: Transparent substrates are considered to have a reflective backside unless
the backside is specially prepared to absorb light incident from the frontside.

Note B: These samples may require a special fixture in order to be measured. Call
Filmetrics for details.

Figure 4.1: Selection tree for identifying the example for specific measurements.
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4.2 Examples

Example 1: Thickness of Films Greater Than %2 Micron Thick: SiO; on Silicon

For this example we will demonstrate only the measurement of SiO, on silicon (the SiO; on silicon
Test Sample provided with the F20 may be used), but this type of measurement has an extremely
broad range of applications, including hardcoats, polysilicon, and LCD cell gaps, to name just a few.

Hardware: If the sample to be measured is flat, any standard or rotating sample stage will work
fine. If the sample is curved, or is transparent with films on its backside (such as eyeglass lens
applications), a hand-held contact probe measurement device (e.g., Part# CP-NIR) may be necessary.

Step 1: Select the film structure

Select the film structure to be measured, in this case “SiO2 on Si”, from the “Structure:” selection
box on the main screen. If the structure to be measured does not exist, a new structure must be
defined (see Section 5.2.)

Step 2: Edit the film structure
Eaowecwes

Momu: F":‘\E o 5 ;] | Delere | Eﬂ;“lﬂﬁ-l
Lmyras I yhuns ] Cusstanis

Bumhnr of | : F r - -
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[T Iﬂi_,l Thickemay, dijd)  Fioughaaes, o (b Masure:
Layer i1 [0 5 K i & & =
Sulrstrate Ii.. ] Ir— Cn Tk o

F Ersasds Puobos Thickrass On

Swsoniie Dete and Somings

Copyrin Impod Fom
o e Exposta Fla Fiv | Friee I | Close

Figure 4.2: Example Edit Structure:Layers window for measuring the thickness of a thin film greater
than ¥2 micron thick.

To edit the structure, click on “Edit Structure” to open the dialog box. Check to see that the film
sequence matches that of the actual sample. If not, different films can be selected (see Section 5.2.)

Also enter your best guess for the thickness of the film to be measured, and check that only the SiO,
layer thickness is being measured.
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Step 3: Take a Baseline Measurement

Take a Baseline measurement by first clicking on the Baseline button on the main screen. On the
Take Baseline dialog box, make certain the “Autoscale Integration Time” option is selected, and
choose the Baseline Sample that will be used (Si in this case). Then put the Baseline sample on the
measurement stage and click on “Take Baseline”. Then remove the Baseline sample from the stage
and click “Take Dark”. (In the case of a contact probe, place the probe on the Baseline sample and
click on “Take Baseline”, and then remove the probe from the sample and click “Take Dark™.)

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage (or the contact probe on your sample)
and click on the “Measure” button. FILMeasure will then acquire the reflectance spectrum and
calculate the corresponding thickness. If the measurement was successful, the minima and the
maxima of the calculated reflectance (the red line on the graph) will coincide in wavelength with the
minima and the maxima of the measured reflectance (the blue line on the graph.) In most cases they
will not overlap, but will be separated in amplitude.

£ FILMeasure - [Main] [ =] =]
Fille Edit SetUp Acquire ‘Window Help

Sample (O |SiO2 on i Cperatar; |
— Measured Data
Cursar Wavelength(nm):l Y:l — Calculstion AR T

5074 A

Bazeline

Measure

ReAnalyze

Structure: ISioz on Si 'I
Edit Structure...
Dizplay: I Thicknesses 'I
5io2= | 5074 A
Fitting Error = I
0 ldeasuremert #: |1

400 500 600 700 800 Show Table | Show Statistics |
Wwavelengthlnm)

Reflectance

Figure 4.3: Measured and calculated reflectance spectra when measuring the thickness of SiO, on
silicon.

If the calculated (red) and measured (blue) minima and maxima do not coincide, then the
measurement was not successful. There are several possible causes of an unsuccessful measurement.
The most common for this type of measurement are described in cases #1, #2, #3, and #4 in the
troubleshooting section.
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Example 2: Thickness of Films Less Than % Micron Thick on Thick Transparent
Substrates: TiO, on Glass

This example demonstrates the measurement of TiO, on glass. This type of measurement has a broad
range of other applications, most commonly optical coating and flat-panel display process films.

Hardware: If the sample to be measured is flat, the contact sample stage should be used. If the
sample is curved, the hand-held contact probe (e.g., Part# CP-NIR) will probably be necessary.

Step 1: Select the film structure

Select the film structure to be measured, in this case “TiO2 on Glass”, from the “Structure:” selection
box on the main screen. If the structure to be measured does not exist, a new structure must be
defined (see Section 5.2.)

Step 2: Edit the film structure
Eciicrs
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Fig Frni | Cloem

Figure 4.4: Example Edit Structure:Layers window for measuring the thickness of a film less than
approximately ¥2 micron thick on a thick transparent.

ECDWII L Exporiia File

To edit the structure, click on “Edit Structure” to open the dialog box. Check to see that the film
sequence matches that of the actual sample. If not, different films can be selected (see Section 5.2.)
Also enter your best guess for the thickness of the film to be measured, and check that only the TiO,
layer thickness is being measured.
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Step 3: Take a Baseline Measurement

Take a Baseline measurement by first clicking on the Baseline button on the main screen. On the
Take Baseline dialog box, make certain the “Autoscale Integration Time” option is selected, and
choose the Baseline Sample that will be used (Si in this case). Then put the Silicon Baseline sample
on the measurement stage and click on “Take Baseline”. Then remove the Baseline sample from the
stage and click “Take Dark”. (In the case of a contact probe, place the probe on the Baseline sample
and click on “Take Baseline”, and then remove the probe from the sample and click “Take Dark’.)

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage (or the contact probe on your sample)
and click on the “Measure” button. FILMeasure will then acquire the reflectance spectrum and
calculate the corresponding thickness. If the measurement was successful, the minima and the
maxima of the calculated reflectance (the red line on the graph) will coincide in wavelength with the
minima and the maxima of the measured reflectance (the blue line on the graph.) In most cases they
will not overlap, but will be separated in amplitude.
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Figure 4.5: Measured and calculated reflectance spectra when measuring the thickness of TiO, on a

glass slide.

Reflectance

If the calculated (red) and measured (blue) minima and maxima do not coincide, then the
measurement was not successful. There are several possible causes of an unsuccessful measurement.
The most common for this type of measurement are described in cases #1, #2, #3, and #4 in the
troubleshooting section.
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Example 3: Thickness of Films Less Than ¥ Micron on Thin Transparent Substrates:
MgF; on Glass slide

In this example we will demonstrate the measurement of MgF; on a glass slide.

Hardware: For this type of measurement the sample must be flat, with the front and backsides
parallel. The standard SS-1 sample stage is required.

Step 1: Select the film structure

Select the film structure to be measured, in this case “MgF2 on Glass”, from the “Structure:”
selection box on the main screen. If the structure to be measured does not exist, a new structure must
be defined (see Section 5.2.)

Step 2: Edit the film structure
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Figure 4.6: Example Edit Structure:Layers window for measuring the thickness of films less than
approximately %2 micron thick on a thin transparent substrate.

To edit the structure, click on “Edit Structure” to open the dialog box. Check to see that the film
sequence matches that of the actual sample. If not, different films can be selected (see Section 5.2.)
Also enter your best guess for the thickness of the film to be measured, and check that only the MgF,
layer thickness is being measured.
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Figure 4.7: Example Edit Structure:Options window for measuring the thickness of films less than
approximately ¥2 micron thick on thin transparent substrate.

Step 3: Take a Baseline Measurement

Take a Baseline measurement by first clicking on the Baseline button on the main screen. On the
Take Baseline dialog box, make certain the “Autoscale Integration Time” option is selected, and
choose the Baseline Sample that will be used (Si in this case). Then put the Silicon Baseline sample
on the measurement stage and click on “Take Baseline”. Then remove the Baseline sample from the
stage and click “Take Dark”. (In the case of a contact probe, place the probe on the Baseline sample
and click on “Take Baseline”, and then remove the probe from the sample and click “Take Dark™.)

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage (or the contact probe on your sample)
and click on the “Measure” button. FILMeasure will then acquire the reflectance spectrum and
calculate the corresponding thickness. If the measurement was successful, the minima and the
maxima of the calculated reflectance (the red line on the graph) will coincide in wavelength with the
minima and the maxima of the measured reflectance (the blue line on the graph.) In most cases they
will not overlap, but will be separated in amplitude.
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Figure 4.8: Measured and calculated reflectance spectra when measuring the thickness of MgF, on a
glass slide.

If the calculated (red) and measured (blue) minima and maxima do not coincide, then the
measurement was not successful. There are several possible causes of an unsuccessful measurement.
The most common for this type of measurement are described in cases #1, #2, #3, and #4 in the

troubleshooting section.
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Example 4: Thickness and Optical Constants of Films on Opaque Substrates: SiO; on
Silicon

For this example we will demonstrate only the measurement of SiO, on silicon (the SiO, on silicon
Test Sample provided with the F20 may be used,) but this type of measurement has an extremely
broad range of applications, including the measurement of nitrides, polysilicon, and optical coatings.

Hardware: Any standard or rotating sample stage should work fine. The sample frontside must be
flat. If the sample backside is not flat and parallel with the frontside, then the contact stage must be
used.

Step 1: Select the film structure

Select the film structure to be measured, in this case “SiO2 on Si”, from the “Structure:” selection
box on the main screen. If the structure to be measured does not exist, a new structure must be
defined (see Section 5.2.)

Step 2: Edit the film structure
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Figure 4.9: Example Edit Structure:Layers window for measuring the thickness, n, and k of films on
an opaque substrate.

For this example the film structure will probably not require editing, unless a different film is being
measured. To edit the structure, click on “Edit Structure” to open the dialog box. Check to see that
the film sequence matches that of the actual sample. If not, different films can be selected (see
Section 5.2.) Also enter your best guess for the thickness of the film to be measured. Also check
that thickness, n, and k of the SiO, layer are selected to be measured.
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Figure 4.10: Example Edit Structure:Options window for measuring the thickness, n, and k of films on
an opaque substrate.

Step 3: Take a Baseline Measurement

Take a Baseline measurement by first clicking on the Baseline button on the main screen. On the
Take Baseline dialog box, make certain the “Autoscale Integration Time” option is selected, and
choose the Baseline Sample that will be used (Si in this case). Then put the Silicon Baseline sample
on the measurement stage and click on “Take Baseline”. Then remove the Baseline sample from the
stage and click “Take Dark”. (In the case of a contact probe, place the probe on the Baseline sample
and click on “Take Baseline”, and then remove the probe from the sample and click “Take Dark™.)

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage (or the contact probe on your sample)
and click on the “Measure” button. FILMeasure will then acquire the reflectance spectrum and
calculate the corresponding thickness. If the measurement was successful, the calculated reflectance
(the red line on the graph) will coincide with the measured reflectance (the blue line on the graph.)

If the measured and calculated spectra do not fall on top of each other, the resulting thickness, n, and
k values are incorrect. If the mismatch between measured data and calculation is only slight, the
results reported will only be off by a small amount. If the measured and calculated spectra match,
but the results are implausible, there may be a problem with the sample positioning and light
collection. Causes and corrective actions to improve the measurements are listed in cases #5 and #6
in the troubleshooting section.
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Figure 4.11: Measured and calculated reflectance spectra when measuring the thickness, n, k, and
roughness of SiO, on silicon.

If the calculated (red) and measured (blue) minima and maxima do not coincide, then the
measurement was not successful. There are several possible causes of an unsuccessful measurement.
The most common for this type of measurement are described in cases #1, #2, #3, and #4 in the

troubleshooting section.
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Figure 4.12: Calculated n and k spectra when measuring the thickness, n, k, and roughness of SiO,
on silicon.
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Example 5: Thickness and Optical Constants of Films on Thick Transparent
Substrates: MgF, on BK7

This type of measurement is typically applied to optical coatings on glass substrates, as well as anti-
reflection coatings on various transparent substrates.

Hardware: The contact stage must be used when measuring the thickness and optical constants of
films on a thick transparent substrate (see Chapter 2 for setup of the contact stage.) Use of the
contact stage means that the frontside of the sample must be flat.

Step 1: Select the film structure

Select the film structure to be measured, in this case “Mg2 on BK7”, from the “Structure:” selection
box on the main screen. If the structure to be measured does not exist, a new structure must be
defined (see Section 5.2.)

Step 2: Edit the film structure
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Figure 4.13: Example Edit Structure:Layers window for measuring the thickness, n, and k of films on
a thick transparent substrate.

For this example the film structure will probably not require editing, unless a different film is being
measured. To edit the structure, click on “Edit Structure” to open the dialog box. Check to see that
the film sequence matches that of the actual sample. If not, different films can be selected (see
Section 5.2.) Also enter your best guess for the thickness of the film to be measured.
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Figure 4.14: Example Edit Structure:Options window for measuring the thickness, n, and k of films on
a thick transparent substrate.

Step 3: Take a Baseline Measurement

Take a Baseline measurement by first clicking on the Baseline button on the main screen. On the
Take Baseline dialog box, make certain the “Autoscale Integration Time” option is selected, and
choose the Baseline Sample that will be used (Si in this case). Then put the Silicon Baseline sample
on the measurement stage and click on “Take Baseline”. Then remove the Baseline sample from the
stage and click “Take Dark”. (In the case of a contact probe, place the probe on the Baseline sample
and click on “Take Baseline”, and then remove the probe from the sample and click “Take Dark™.)

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage (or the contact probe on your sample)
and click on the “Measure” button. FILMeasure will then acquire the reflectance spectrum and
calculate the corresponding thickness. If the measurement was successful, the minima and the
maxima of the calculated reflectance (the red line on the graph) will coincide in wavelength with the
minima and the maxima of the measured reflectance (the blue line on the graph.) In most cases they
will not overlap, but will be separated in amplitude.

If the measured and calculated spectra do not fall on top of each other, the resulting thickness, n, and
k values are incorrect. If the mismatch between measured data and calculation is only slight, the
results reported will only be off by a small amount. If the measured and calculated spectra match,
but the results are implausible there may be a problem with the sample positioning and light
collection. Causes and corrective actions to improve the measurements are listed in cases #5 and #6
in the troubleshooting section.
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Figure 4.15: Measured and calculated reflectance spectra when measuring the thickness, n, k, and
roughness of MgF, on BK7 glass.

If the calculated (red) and measured (blue) minima and maxima do not coincide, then the
measurement was not successful. There are several possible causes of an unsuccessful measurement.
The most common for this type of measurement are described in cases #1, #2, #3, and #4 in the

troubleshooting section.
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Figure 4.16: Calculated n and k spectra when measuring the thickness, n, k, and roughness of MgF,
on BK7 glass.
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Example 6: Transmission Measurements: Polymer Film on Acrylic
For this example we will demonstrate the measurement of a thin polymer layer on acrylic.

Hardware: For this type of measurement the sample must be flat, with the front and backsides
parallel. The standard sample stage equipped with the T-1, Transmission option is required. When
measuring very thin films, use of a vacuum plugged into the vacuum port is recommended.

Step 1: Select the film structure

Select the film structure to be measured, in this case “Transmission”, from the “Structure:” selection
box on the mail screen. If the structure to be measured does not exist, a new structure must be
defined (see Section 5.2).
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Figure 4.17: Example Edit Structure:Layers window for measuring transmission.

Step 2: Edit the film structure

To edit the structure, click on “Edit Structure” to open the dialog box. Check to see that the film
sequence matches that of the actual sample. If not, different films can be selected (see Section 5.2).
Also, enter your best guess for the thickness of the film to be measured, and check that only Layer #1
thickness is being measured. Verify that the Transmittance Measurement Type is selected under the
Options Tab and “Enable Robust Thickness Only” is deselected.
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Figure 4.18: Example Edit Structure:Options window for measuring transmission.

Step 3: Take a Baseline Measurement

Select Set Up from the Main Menu and activate Transmittance Mode. Then take a Baseline
measurement by first clicking on the Baseline button on the main screen. On the Take Baseline
dialog box, make certain the “Autoscale Integration Time” option is selected. In the drop-down box,
choose the Baseline Sample that will be used. See below for instructions on how to generate this file.
Place the bare substrate on the stage in the light beam and click on “Take Baseline”. [If measuring
layers on a very thin substrate (less than 1 mm), select “Enter Constant...” and enter “1” to use air as
the reference. Then click on “Take Baseline” while the beam is unblocked.] Finally, place an opaque
object on the stage to block the beam and click “Take Dark”. Note: Most glass and plastics absorb
UV light below 350 nm, displayed as a sudden drop in transmittance at those wavelengths.

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage and click on the “Measure” button.
FILMeasure will then acquire the reflectance spectrum and calculate the corresponding thickness. If
the measurement was successful, the minima and the maxima of the calculated transmittance (the red
line on the graph) will coincide in wavelength with the minima and the maxima of the measured
transmittance (the blue line on the graph.) In most cases they will not overlap, but will be separated
in amplitude. If the calculated (red) and measured (blue) minima and maxima do not coincide, then
the measurement was not successful. There are several possible causes of an unsuccessful
measurement. The most common for this type of measurement are described in cases #1, #2, #3, and
#4 in the troubleshooting section. In the case of thin metal layers on a clear substrate: Minima and
maxima in the blue (measured transmittance) and red curves (calculated transmittance) may not
occur for thin metal layers and the curves may not overlap. In most cases the measurement was
successful if the average transmittance value of both curves coincide.
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Figure 4.19: Measured and calculated reflectance spectra when measuring the transmission of a
polymer film on acrylic.

How to Create a Transmission Reference File:

Reference files for specific materials are used when taking baseline measurements. The reference
files sent with the F20 are for reflectance measurements only. A transmission reference file may be
easily created by setting up the software to solve for theoretical transmittance of a bare substrate
based on a known material in the material library. No actual measurement is needed.

1. Open any data file.
2. Set the graphical display for the full wavelength range of the system.

3. Click on the Edit Structure button to open the Structure setup area.

a) Set the structure to indicate the Medium and Substrate as air. Select the reference
material from the layer drop-down box. This material must have an index file in the
library. For example, transmission measurements of a film on a BSG slide require a
baseline measurement of a BSG slide reference sample in transmission mode. To
generate the reference file for this reference sample the structure must be set to Air
(Medium) on BSG (Layer #1) on Air (Substrate).

b) Enter the approximate thickness for the reference sample. In this example, the BSG slide
is 2 mm thick.
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Figure 4.20: Example Edit Structure:Layers window for generating transmission reference file.

¢) Under the Options tab, select the Measurement Type: Transmittance.

d) Uncheck all Measure boxes. By deselecting the measurement boxes, the calculated curve
represents the theoretical transmittance spectrum for the reference sample.

e) Close the Edit Structure box.
Use the reanalyze button to calculate the transmission spectrum.
Select File | Save Calculated Spectrum As... and save the file in the Materials directory.

In Windows Explorer, rename this file with the extension *“.rrr".

N o g &

In a text editor, change the headers generated by the program to one line reading
"Wavelength (nm), Transmittance".

This new file will be listed in the reference materials drop-down box found in the Baseline
procedures.
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4.3 Measurement Assumptions

The following assumptions must be valid if accurate measurements are to be made with the F20:

1)

2)

Every film present in the structure is specified in the "Edit Structure™ dialog box. This includes
every film present in the sample including so-called adhesion films, oxide films (unless they are
less than 20 A or greater than 150 microns thick), and films on the bottom surface of the
substrate if the substrate is transparent.

The thickness of the measured film is uniform over the spot being measured.

In addition, the following assumptions are made if optical constants and/or very thin films (<500 A)
are to be measured :

3)

4)

5)

6)

7)

8)

9

Each film in the structure is homogeneous and uniform (i.e. the refractive index and extinction
coefficient are constant as a function of depth and constant over the entire spot being measured).

No significant scattering of the light incident on the sample is occurring, unless it is caused be
slight surface roughness that is being accounted for in the Structure definition.

The top surface of the sample under test is at the same height as the reference sample that was
used to make the reference calibration measurement.

The sample is flat (the vacuum chuck may help in this case when samples are warped.).

No changes to the measurement system (such as fibers moved) or light source have occurred
since the acquisition of the most recent baseline.

The light source has been allowed to warm up for approximately 15 minutes.

No significant changes in room temperature (> 10 degrees F) have occurred since acquisition of
the most recent baseline.

If any of the above assumptions are not true, it may still be possible to make a measurement, but
accuracy may be degraded.

4.4 Hints for Improved Accuracy

Roughness

Slight amounts of surface or interface roughness may be present that will decrease the accuracy of
the measurement of optical constants. Entering a value for or solving for roughness can account for
this roughness, so that optical constants can be measured. Generally, roughness is only present when
the sample surface looks hazy at the measurement spot. The fact that this haze can be seen means
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that there is scattered light. (A perfectly smooth surface will scatter no light, and thus the measured
spot will not be visible.) Usually roughness less than 25 A will not be visible and will have little
effect on measurement results. Roughness greater than about 200 A will be extremely hazy to the
point accurate measurement of optical constants will not be possible.

Restricting the wavelength range of the analyzed reflectance spectrum

Occasionally the reflectance spectra from measured films is adversely affected by factors such as
absorbing dyes, birefringence, or non-uniformity, none of which can be properly modeled. It may be
possible to still make accurate thickness measurements of these films by analyzing only the portions
of the spectra that contain valid, uncorrupted thickness information (i.e., oscillations.) The portion of
the reflectance spectrum that is used to calculate film properties is determined by the graphic display,
i.e., only the data shown on the screen is used in the calculations. Therefore, to measure values using
a restricted wavelength range, simply select a narrower range by double-clicking on the screen to
bring up the "Graph Options" dialog box. An example is shown in Figure 4.17 and 4.18. Restricting
the wavelength range can also be helpful in optical constant measurements if n and k are not
accurately described over the whole wavelength range by a single model.
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Figure 4.21: Example of non-ideal film (spectrum with no oscillations at lower wavelengths) that
requires reduced wavelength range for accurate thickness measurement.
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Figure 4.22: Example of reduced wavelength range for measuring thickness of non-ideal films.

Measuring thickness when the approximate thickness is not well known

Unless otherwise specified, FILMeasure will determine a film’s thickness by finding the best answer
within about 1000 A of the initial (user supplied) value. If the approximate thickness of the film is
not known to better than about 1000 A, then the Grid method or the Fourier Transform method of
determining approximate thickness may be applied. See Chapter 5 for more details.

Measuring photosensitive films

For layers such as unexposed photoresist that can not be exposed to short-wavelength light, a filter
may be inserted in the slot on the light source.

4.5 Troubleshooting

Incorrect or unreasonable measurement results can be caused by a number of different factors.
Below are listed some of the more common symptoms and solutions for poor measurement results.
In all cases it has been assumed that the user has read the Measurement Assumptions section listed
above, and that each criteria has been met.

Case #1: No oscillations, or portions of oscillations, are present in the measured reflectance
spectrum. There can be several causes of this. The simplest is that the film may just be very thin
(<200 A)) Also, if the film is very rough, non-uniform in thickness over the measurement area, or
has a graded interface, it may not support coherent optical interference, and thus it may not be able to
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be measured. Another cause of no oscillations can be an improper baseline measurement, so usually
the first step when no oscillations are seen is to carefully retake the baseline.

Case #2: The measured reflectance spectrum has periodic oscillations across the entire screen, but
its minima and maxima do not match up with the calculated reflectance. The most common cause is
that the initial thickness guess was considerably different than the actual film thickness, and due to
the constraints on possible thicknesses, FILMeasure was not able to look for an answer in the region
of the actual thickness. To understand this, it helps to know that the number of oscillations on the
screen is proportional to the film thickness. For example, if the measured spectrum has roughly
twice the number of the oscillations that the calculated spectrum has, then the measured film is
roughly twice the thickness of the calculated thickness. Using this information, the initial thickness
guess and the thickness constraints can be set more appropriately in the Edit Structure dialog box.
Another possible cause is found in case #3 (incorrect dispersion.)

Case #3: Two or more different, but nearly the same, thickness readings are obtainable from the
same measurement location. When this occurs usually the measured and calculated spectra match
somewhat, but not very well across the entire spectra (usually, the measured and calculated spectra
match only over a small wavelength range and then gradually walk off one another outside this
wavelength range.) When thickness is the only value being measured, this is normally caused by the
refractive index of the measured layer not matching that used by FILMeasure, especially when the
film is greater than one micron thick. Unless more accurate index values can be obtained, the best
way to solve this problem is to restrict the wavelength range used in the analysis.

Case #4: Not all of the measured spectrum displays oscillations, some regions of the spectrum are
strangely curved (thickness greater than 1 micron.) This can be a symptom of non-uniformity in
thicker films. In this case simply restrict the wavelength range used in the analysis.

Case #5: Poor matches between the measured and calculated reflectance spectra when measuring
thickness and optical constants. There can be many causes of this problem, including those listed in
Case #1 and Case #2 above. Most commonly when a poor fit between the spectra occurs, it is
because 1) the components of the film structure are not all included in the Edit Structure > Layers
dialog box, 2) very inaccurate initial guesses for the film thickness(es) have been listed, 3) the optical
constants listed in the Edit Structure > Layers dialog box are far from the actual optical constants in
the material, or 4) the film being measured has properties that are not taken into account by
FILMeasure. Examples of these properties are graded interfaces, non-uniform films, and voids.

Case #6: Several different answers, or one unreasonable answer, are found when measuring
thickness and optical constants, although a good match is found between the measured and calculated
reflectance spectra. This normally occurs when a large number of properties are being measured on a
very thin film. In general, the thinner a film is, the less unique information that can be obtained from
it. To understand this, read Measurement Theory in Appendix C. To solve the problem, one must
usually reduce the number of properties being measured.
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Chapter 5 Details of Operation

The basic steps for any F20 measurement are selecting and editing the film structure, taking a
baseline measurement, and then making and evaluating the measurement. The details of each of
these steps are explained below, followed by descriptions of other FILMeasure functions.

5.1 Taking a Baseline

The baseline measurement allows the FILMeasure software to take into account the response
inherent to the F20 reflectance measurement hardware. It does this by measuring a reference sample
and by taking a “dark” reading. If optical constants or very thin films are to be measured, the light
source should be allowed to stabilize at least ten minutes before the baseline is taken, and then
periodically re-taken every 20-30 minutes. A baseline measurement is taken by clicking on the
Baseline button on the main screen and following the prompts. The steps for taking the baseline are
explained in detail here.

The first step is to take a reference spectrum. This done by placing the reference sample (usually
silicon or BK7 glass) on the sample stage and clicking OK when prompted. The reference material
that is used should be selected in the Reference list. If the film structure to be measured has already
been selected from the “Structure:” list, then Autoscale Integration Time can be selected. In some
instances this will not be possible and the instructions for setting the integration time with the
Setup > Data Acquisition box will have to be followed.

The dark scan should be taken with no sample on the stage and the light turned on (so that the light
output remains stable). Most stages have a built-in tilted mirror or other reflector that is used to re-
direct the incident light away from the collection optics. If you are using a movable stage, move this
reflector under the light beam. Click on “OK?” to take the dark reading.

After acquiring a baseline the F20 is ready to begin making measurements. To verify that the system
is working properly, you may select Acquire > Do Single Acquisition with the reference sample in
place. You should see the reflectance spectrum of the reference material.

5.2 Editing Film Structures

The film characteristics that are to be measured, and the description of the sample film structure are
specified in the "Edit Structure" dialog box. Dozens of different film structures and their
measurement specifications may be saved using the "Edit Structure™ dialog box.
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The "Edit Structure” dialog box is accessed with the "Edit Structure” button on the right-hand side of
the main screen. The "Edit Structure” dialog box lists an initial guess at the specifications of the film
structure to be measured. These specifications include the name of the film structure (which
identifies it in the "Structure:" list), the number of films in the structure, the specifications of
individual films, and the quantities to be measured.

Edit Structure > Adding, Changing, or Deleting a Structure

When the "Edit Structure" dialog box is opened, it shows the stored specifications of the structure
selected from the "Structure:" list, along with any changes made since the program was started.
Changes to the structure selected can be permanently stored by making the desired changes and then
clicking on "Save Changes". New structures may be added to the "Structure:" list by opening the
"Edit Structure” dialog box, entering the name of the new structure in the "Name:" field, setting the
desired specifications, and then clicking on "Save As New". Similarly, a structure may be deleted
(removed from the “Structure:” list) by clicking on the “Delete” button.

Mams: |[Fuby/Sild o G x| Eowdapew]| Dabs | Zove Change |

Lasais | Dptisar | Conshmisiz

Mamdedt ofLayuiec © 1 S F 3 4

HArgio: Walnrinl
Medism [ -] Thchness d A Fosghsess r A (TR
Lunyer 81 |0 = Fd Sn Fk Fr
Layer 2 |20 = ] Fd ©an 'k FRr
Substrate - <] T n Ik Fr
=]
Siucturs Dalo and Sutinga
E-Em-u?:l Exzatic Fila "W::'"“ Pari Cluws

Figure 5.1: Edit Structure > Layers window

Edit Structure > Layers: Setting Up a Film Structure

When solving for a parameter, the specifications (d, n, k, roughness) of the known films (including
the incident medium and substrate) must be entered into the proper fields in the "Edit Structure”
dialog box, as well as initial guesses for the values to be measured. The refractive index (n) and
extinction coefficient (k) values for common materials can be selected automatically with the pull-
down menus on the left-hand side of the "Edit Structure" dialog box.

If a material is being measured which is not present in the pop-up material list there are three
possible approaches: a) choose a material in the list which is similar, b) if the material is transparent
(an insulator), select “Enter Refractive Index Value” from the material list and enter a value for the
refractive index (n will automatically be varied by FILMeasure, with the entered value being n at 632
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nm), or c) in the Edit > Edit Material Library dialog box, enter the refractive index values for n and k
as a function of wavelength and save the files so that they may be selected as in a).

Edit Structure > Layers: Choosing Film Properties to be Measured

To measure a film property, check the appropriate box on the right-hand side of the “Layers” field in
the Edit Structure dialog box. In general, thickness values can be measured independently if the n
and k of the layer are specified. However, unless the thickness is extremely well-known, n and k can
not be measured without also measuring thickness. Also, unless the material is a dielectric (k=0), n
and k must be measured together.

As with any measurement, the accuracy of the measured data decreases as the number of measured
values increases. This is especially true here, as changes in d, n, and k can often affect the measured
reflectance spectrum in similar ways. Thus it is best to provide as much information about the film
structure as possible.

Edit Structure > Layers: “Robust Thickness Only” Mode

If thickness is the only property to be measured and the film to be measured is greater than 5000 A
thick, the “Robust Thickness Only” mode may be used. This mode can oftentimes allow for
successful measurements to be made when the reflectance data is affected by non-ideal film
properties, such as non-uniformities and birefringence. In this mode, if the thickness entry field is
empty, FILMeasure will search for the best thickness fit between approximately 20 A and 100 um
(Caution: Measuring thickness in this mode may take a considerable amount of time.) If a thickness
value is entered, the range of thicknesses tested is constrained by the limits set in the "Constraints"
field.

Edit Structure > Options

Correct setting of the following options will help insure accurate measurements. Many of the options
are set automatically when film information is supplied in the "Edit Structure” dialog box, and all of
them can be saved so that subsequent measurements can be made as quickly and easily as possible.

Most of the options are self-explanatory: measurements may be made in reflection or transmission
mode; the angle of the incident light may be varied, with normal incidence defined as zero degrees;
and transverse electric and magnetic polarization may be selected when the incident angle is not zero.

41



Mame: [SI0F/pahy 50T on S v | Sewdaphew| Dol | Sovs Chasges |

Leryars | Dptioss T Consimiss
By Dulads Comypir guemece Crikira Dira ey Distenl s
I i seauch tar fickmess P el
™ Eramesr smschior Bickress Firsy Enar Lass Thas n:iF:'
™ &ocaunlor Seck At cicra A T B |Ell drplry
Ak Mg Wi e el Ty | §128  mm
o Beleisnoe
" Triomaretar Annknd Dsts
Lol | ¥ " = D
= Eivalwsneous Rl [Ters, Dbyl
Lot TN - | F FondPange
Frim
Leya x| = e
m
Sutvera | | I'rDﬂ-Ill-:-ri]l:-l | degses To
Folarcelon FTE © T | nm
Structers Onin mad Sebnge
Copwin Wi P
Cipkoan Expariz Fis Fig | Frri | Cinen

Figure 5.2: Edit Structure > Options window

Edit Structure > Options: Grid Search for Thickness

There are a number of methods that FILMeasure can use to determine thickness, n, and k. None is
perfect—each is a different trade-off between speed, accuracy, and robustness (i.e., the ability to find
the best solution among many that are nearly as good.) Because thickness can vary over many orders
of magnitude and many near-solutions exist, it is often best to use a very robust method to get close
to the best solution, and then let a more accurate method take over. One very robust method is the
"Grid" method, which can be activated by selecting "Grid Search for Thickness." The Grid method
searches the entire allowed thickness range (as defined by the initial guess and the constraints) to
find the best initial thickness. However, on some very complex spectra, it is possible for the Grid
method to become confused and give the wrong answer. In such cases it is best to measure without
the Grid method by using accurate initial guesses to get close to the final solution.

Edit Structure > Options: Fourier Search for Thickness

The Fourier Transform method is an alternative option to let FILMeasure choose an initial thickness
for analysis. The Fourier Transform method analyzes the oscillations present in the spectrum and
determines the film thicknesses based on the periodicity of those oscillations. It is somewhat less
robust than the Grid method, but is better at finding the correct thickness in cases where the shape of
the initial theoretical spectrum is different than the measured data (i.e., the reflectance spectrum is
non-ideal in some way) or in cases where there is more than one film thickness is being measured.

Edit Structure > Options: Convergence Criteria

This sets the maximum error between the measured and calculated spectra that is attained before the
measurement routines consider the solution final. In most cases a value of 0.005 is sufficient (for
how this is calculated, see Fitting Error in Section 5.3.) For cases where the desired Fitting Error is
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not attainable, the value in "Maximum Iterations:" limits the number of iterations performed by the
analysis routine.

Edit Structure > Options: Models for n and k

When measuring n and k for a film, the general dependence of these values upon wavelength must be
specified. This dependence is determined by the type of material to be measured. For example,
insulators, semiconductors, and metals all have a unique type of n and k wavelength dependence.
Dozens of models for these different dependencies have been proposed and used over the years.
FILMeasure uses a few of the most versatile and accepted of these models. For insulators, the
Cauchy model is used, for semiconductors, either the Amorphous or Bridge-Lorentzian model, and
for metals, the Drude model. These models are selected automatically when a material is chosen
from the Material lists on the "Edit Structure..." dialog box. Other models may also be specified by
selecting them from the "nk Model" box in the "Options..." dialog box.

Edit Structure > Constraints

By setting constraints, the user can limit the possible values of the measured film properties. The
constraints are set in conjunction with the values entered in the Edit Structure > Layers dialog box.
For example, if the initial guess of the measured thickness of a film is 1000 A and the thickness
constraint is set at +/- 50%, FILMeasure will only consider possible thicknesses in the range 500 A to
1500 A. Constraining the measurement range can speed up the measurements and can also help
exclude non-physical solutions.

5.3 Understanding and Evaluating Measurement Results

Display of Measured Data

Once film structure and measurement information have been entered and baseline spectra taken,
measurements may be made by clicking on the "Measure" button. After measurement, the measured
and calculated reflectance spectra are displayed on the graph. The thickness of the films are listed in
the boxes labeled "Layer 1:", "Layer 2:", etc. (actual material names are used if entered in the index
box for each film layer). If any of the thickness values were measured, they are displayed in bold
numbers.

The values of the calculated reflectance versus wavelength are listed in the grid that is viewed by
clicking on “Show Table” at the lower right-hand corner of the screen The calculated n and k values
may be viewed by scrolling through the grid. Clicking on a column containing measured data will
cause it to be plotted on the graph.

Selected data from the results grid may be copied to the clipboard by clicking on "Copy Selected
Data". The wavelength data is copied along with the selected reflectance, n, and/or k data.

Fitting Error

The accuracy of a calculation fit, and thus the reliability of the measurement, can be judged by the
match between the measured and calculated spectra, which is quantified by the Fitting Error value.
The Fitting Error is a normalized average RMS difference between the measured and calculated
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spectra points. Of course, the smaller the error value, the better the fit, and the more reliable the
measured values. The actual value of the Fitting Error is quite dependent upon the type of
measurement being made, but, as a general guideline, a good measurement of thickness and optical
constants occurs when it is in the neighborhood of 0.01 or less.

5.4 The File Menu

File > Open Reflectance Spectrum...
This command is used to open stored reflectance spectra, which are then displayed and can be
analyzed for film properties.

File > Save Measured Spectrum...

This command is used to save measured reflectance spectrum for export or later analysis. All data is
saved along with the corresponding wavelength data in comma-delimited format.

File > Save Calculated Spectrum...
This command is used to save the calculated reflectance spectrum for export or later analysis. All
data is saved along with the corresponding wavelength data in comma-delimited format.

5.5 The Edit Menu

Edit > Copy Measured Spectrum...
This command is used to copy the Measured reflectance spectrum and corresponding wavelength
data in comma-delimited format.

Edit > Copy Calculated Spectrum...
This command is used to copy the calculated reflectance spectrum and corresponding wavelength
data in comma-delimited format.

Edit > Material Library...

The files that FILMeasure uses to describe n and k of different materials can be edited by selecting
Edit > Material Library... The files that are used to describe n and the material type (e.g., dielectric,
semiconductor, metal) are designated index files and have the extension “.nnn”. The files that
describe k have the extension “.kkk”.
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Figure 5.3: The Edit > Material Library dialog box

A new material may be entered into the material library using the following steps:

1. Manually: If refractive index (n) and extinction coefficient (k) are known as a function of
wavelength for the new material, they may be manually added to the library. For each
material there is a file that contains index values as a function of wavelength. This file is
named material.nnn. Optionally, a .kkk file may be created. If no .kkk file is created, k is
assumed to equal zero over the entire spectrum.

a)

b)

c)
d)

Under the "Edit" menu item, select "Material Library". The “Edit Material” dialog box
will appear.

Click on the "New" button to create a new material.

Select the type of file you are ready to create (.nnn or .kkK).

Optimize the functionality of the file by entering index values over the entire wavelength
spectrum of the system. The wavelength unit is nanometers. Enter index information
every 20 to 50 nm, depending on the complexity of the data. In areas where n or k are
quickly changing, more densely spaced the points should be entered.

2. Automatically: Measured refractive index (n) and extinction coefficient (k) as a function of
wavelength may also be saved directly to the material library.

a)

b)

Follow the instructions for measuring optical constants, solving for refractive index and,
if non-zero, extinction coefficient (see Section 4.3 and Section 4.4 for suggestions).

Once a good fit is achieved, save the information by selecting "Save n and k to files..."
under the "File" menu. This will save the refractive index (n) and extinction coefficient
(k) as a function of wavelength to their respective files with extensions “.nnn” and
“.kkk”. Name the material as you would like it to appear in the drop down boxes in the
Edit Structure.

Edit > Units...

The thickness (length) units used to describe structures and display results are chosen here. The
choices include nanometers (nm, 10e”® m), microns (um, 10e® m), angstroms (A, 10e™ m), and kilo-
angstroms (KA, 10e” m).
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5.6 The Setup Menu

Data Acquigition: Spectrometer

Auto Integration Time: [
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Figure 5.4: The Setup > Data Acquisition dialog box

Setup > Data Acquisition: Integration Time

This control is used when manually setting the integration time (i.e., when not using Automatic
Integration Time.) To set the integration time, make sure that "Use Background” and "Use
Reference" are not checked and enter a time into the “Integration Time” field and click OK. A value
of 100 ms is a good starting point. To facilitate rapid adjustment of the integration time, select
Acquire > Start Continuous Acquisition. FILMeasure will now be continuously acquiring and
displaying scans. If the scan is off-scale select Setup > Graph Options... and “AutoScale Y axis” to
rescale the axes. Now turn the light source on and insert a test sample. The vertical scale of the
spectrum extends from zero to 4095 (since the A-to-D conversion uses 12 bits). Thus, a good
working level is when the peak height of the sample being measured, or the reference sample, which
ever is greater, is 3000-3500 counts (Note: if the reference measurement saturates, spurious final
measurements will result). If the maximum signal is too low, increase the integration time.

Setup > Data Acquisition: Reference Material

Enter here the reflectance (or transmissivity if in transmission measurement mode) value of the
reference sample used. For transmission measurements, enter 1.0. For reflectance measurements, the
reflector should have known reflectance characteristics over the region of interest. The reflectance
versus wavelength values should be entered into a text file with the extension ".rrr" (stored in the
"Material" subfolder). Materials that already have “.rrr” extensions are available by selecting from
the list in the "Reference Material" field.

Setup > Data Acquisition: Take Dark
This button allows the dark portion of the baseline measurement to be taken without having to re-take
the reference measurement.
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Setup > Data Acquisition: Take Reference
This button allows the reference portion of the baseline measurement to be taken without having to
re-take the dark measurement.

Setup > Data Acquisition: Subtract Dark
This feature allows the dark subtraction portion of the baseline correction to be disabled.

Setup > Data Acquisition: Use Reference
This feature allows the reference portion of the baseline correction to be disabled..

Setup > Data Analysis: Data Smoothing

This is essentially a function that averages together a number of data points on either side of each
measured data point. For example, if the “Smoothing Points” is set to 5 then each data point
displayed on the screen is actually an average of five data points (the data point plus the two data
points on either side). This function can be used to reduce noise when reflectance signals are very
weak.

Setup > Data Analysis: Scans to Average

In order to get the low noise spectrum it is occasionally necessary to acquire a number of reflectance
spectra and display their average. This is readily accomplished by setting the “Scans to Average”
field.

Setup > Access Control...

The software for the F20 incorporates password protection to limit access to the measurement
software and settings. When the software is initially installed the access control is turned off. The
software will automatically boot up with Engineer level access which enables access to all features of
the program except turning on and off access control and adding and deleting users.

The access control options are accessed from the Set Up menu. Turning on access control requires
Supervisor level access. The software is delivered with one user, a supervisor, in the list of
authorized users as shown below:

UserlID: filmsuper
Password: filmetricsfff

To turn on access control, log in as filmsuper using the password shown above. The “Activate
Access Control” check box should now be enabled. By placing a check mark in the Activate Access
Control check box access control will be active.

You should also create some users at this time. To add an operator level user, select operator from
the access level list box, type a user name and type an initial password for that user. Then click the
Add User button. To add an engineer or a supervisor user follow the same procedure, but pick the
appropriate access level from the list box before pressing the Add User button.

To Delete a user, enter the UserID and press the Delete User button.

Operator and Engineer level users can change their passwords when they are logged in by entering
their password into the password box and pressing the change button. Supervisor-level users can
change their password or the password of any other user by selecting the appropriate access level,
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entering the appropriate UserID and the new password and pressing Add User. If the program finds
that a user already exists, it will delete the old entry for that user and create a new entry.

We recommend that you create a new supervisor level user and delete the filmsuper user for
maximum security. If all supervisor level users forget their passwords, it will be necessary to re-
install the software and add all the users again.

Setup > Graph Options: Axis Fields

The "Graph Options" dialog box may also be accessed by double-clicking on the graph display. The
Horizontal Axis Minimum and Maximum fields are used to control the wavelength range displayed
on the screen. The selected range also controls the range of wavelengths that FILMeasure analyzes
when determining film properties. Use the Vertical Axis Minimum and Maximum fields to control
the vertical-axis display. Check the Autoscale Y axis box to activate y-axis autoscaling. The lower
value is always 0 for autoscaling, the maximum y-axis upper limit is 5000.

Setup > Graph Options: Display n and k on One Graph

Check this box to cause n and k to be graphed together on the same plot. If this option is not checked
n will be graphed along with the initial guess for n and k with the initial guess for k. Scroll the
spreadsheet displaying wavelength, n and k left or right to plot n or k on the graph.

Setup > Reflection Mode (Transmission Mode)

Choose the correct mode of operation before beginning a baseline measurement. The measurement
settings are stored for each of the two possibilities. After taking a baseline in reference and in
transmission, this feature allows for switching between reflection and transmission with out taking
any other baselines.

48



Chapter 6 How to Contact Us

We welcome suggestions from our users on ways to improve our software and hardware. Please send
us any suggestions you may have for improvements in the manual or new features you would like to
see in the software.

We may be reached by phone at 858-573-9300, by fax at 858-573-9400, or by e-mail at
support@filmetrics.com.
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Appendix A Performance Specifications

Thickness Measurement Range1

F20 150 A to 50 pm ?
F20UV 30 Ato 20 um
Optical Constant Measurement Range
F20 1000 A to 5 pm
F20-UV 500 A to 5 um
Spot Size

Adjustable 500 umto 1 cm

Thickness Accuracy®
+ 1 nm at 500 nm thickness

Precision®
0.1 nm

Repeatability®
0.07 nm

! Typical Values

2 Custom configuration available to measure thickness up to 100 pm.

® Thermally grown SiO, on Si.

* Standard deviation of 100 thickness readings of 500 nm SiO, film on silicon substrate. Value is average of
standard deviations measured over twenty successive days.

®> Two sigma based on daily average of 100 readings of 500 nm SiO, film on silicon, measured over twenty
successive days.
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Appendix B Application Note: Silicon Nitride

Step-by-step instructions for measuring silicon nitride on Si:

1. Start FILMeasure and click the Edit Structure button.

2. Where it says “Number of Layers:” click on 1.

3. Set the material for the Medium to Air.

4. Set the material for Layer #1 to Si3N4.

5. Enter a guess for the layer thickness of the silicon nitride into the thickness box for layer
#1.

Put check marks in the d, n, and k check boxes for layer #1.

. Set the material for the Substrate to Si.
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Fig. B.1 Settings for steps 1-7

8. Click on the Options tab.
9. Click on “Grid search for thickness” under Solving Details.
10. Make sure there is no check mark for “Account for Back Reflections.”
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11. Under Convergence Criteria, set the number of iterations to 600 and set “Fitting Error less
than:” to 0.001

12. Under Analyzed data select “Fixed Range” and enter “From:” 200 and “To:” 1100

13. Under “Measurement Type” select “Reflectivity.”

Fig. B.2 Settings for steps 8-13

14. Click on the constraints tab.
15. Set the constraint for d to 75%.
16. Set the constraint for n to 5 and the constraint for k to 5.

Fig. B.3 Settings for steps 14-16
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17. In the name field at the top of the Edit Structure Dialog box enter a name for this
structure.

18. Click the “Save As New” button.

19. Click the OK button.

20. Follow the instructions in the manual for measuring dielectric layers.

Discussion

Silicon nitride is a dielectric material commonly used in semiconductor fabrication processes.
The refractive index of stoichiometric Silicon Nitride is 2.05 at 633 nm. However, in practice
the refractive index of deposited films can vary from 1.7 or less (films containing excess
hydrogen or oxygen) to as high as 2.5 or more (Si rich films). The measurement of n and Kk is
complicated by the fact that this refractive index range (1.7 to 2.5) spans a critical range for
films deposited on Si substrates. In order to get an unambiguous result for measurement of n,
the structure description should be set by choosing Si3N4 as the material for the silicon
nitride layer. To confirm that the proper model is chosen, go to the options tab and note that
the model displayed is Si3N4. If the Si3N4 model is not displayed in the nk model list and
Si3N4 is not in the list of models, then newer software is required. It is important that both n
and k be measured simultaneously (put a check mark for n and for k in the Edit Structure
dialog box). When using the Si3N4 model the constraints for n and k should be set to large
values (at least 5). If the film is very thin (less than 50 nm) or if the user has an infrared
spectrometer (e.g. F20-NIR) it may be necessary to set the material to Si3N4 (k=0) instead of
Si3N4 to get reproducible results, but this should be used as a last resort.

Theoretical Underpinnings of Si3N4 n and k Measurement

The refractive index of a single layer film is related primarily to the depth of the minima
found in the measured reflectance. The reflectivity at the interference fringe minima of a film
deposited onto Si is zero when the refractive index is near 1.97. The reflectivity at the fringe
minima for a film with a refractive index of 2.00 is the same as that for a film with a
refractive index of 1.94. Therefore, it can be difficult to unambiguously determine the
refractive index from a reflectance measurement. However, for most films the user knows
that the refractive index is either always greater than or always less than 1.97 so there is no
uncertainty. Silicon nitride is one of the few rare films whose refractive index spans this
critical range. Fortunately, there is a solution for silicon nitride that allows us to determine
which of the two possible refractive index values is correct. This is done by measuring both n
and k for silicon nitride and by realizing that silicon nitride with a refractive index larger than
1.97 has measurable absorption (non-zero k) at wavelengths less than 420 nm. Thus, to get
good results for n the widest possible wavelength range should be used (especially going
down to short wavelengths) and the user should simultaneously measure both n and k.
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Appendix C Theory of Operation

Measurement Theory
The F20 measures thin-film characteristics by either reflecting or transmitting light through the

sample, and then analyzing this light gver a range of wavelengths: Because of its wave-like
properties, light reflected from the top and bottom interfaces of a thin-film can be in-phase so that
reflections add, or out-of-phase so that reflections subtract. Whether the reflections are in- or out-of-
phase (or somewhere in between) depends on the wavelength of the light, as well as the thickness
and properties of the film (e.g., reflections are in-phase when A = (2*n*d)/i, where A is the
wavelength, n is the refractive index, d is the film thickness, and i is an integer.) The result is
characteristic intensity oscillations in the reflectance spectrum (see Fig. C.1.) In general, the thicker
the film, the more oscillations there are in a given wavelength range.
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Figure C.1: Example of Reflectance Spectrum with Oscillations
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The amplitude of the oscillations is determined by the refractive index and extinction coefficient of
the films and substrate. Therefore, by analyzing the period and amplitude of these oscillations, the
F20 can determine thickness and optical properties (n and k) of multiple thin-films.

Thickness Measurement Details

Optical thin-film thickness measurements require the successful completion of two tasks: acquisition
and then analysis of an accurate reflectance spectrum. To determine film thickness, FILMeasure
calculates a reflectance spectrum that matches as closely as possible the measured spectrum.
FILMeasure begins with an initial guess for what the reflectance spectrum should look like
theoretically, based on the user’s input of a film structure for the sample. Then FILMeasure varies
the parameters it is solving for until the calculated reflectance spectrum matches the measured data.
Mathematically, this procedure is complicated by the fact that as the thickness of the films in the
calculation is varied there can be many near matches. Therefore, an approach that simply homes in
on a solution by finding successively better approximations will not work unless the starting guess
for optical thickness is within approximately 1000 A if the actual thickness.

In measuring thickness only, FILMeasure avoids homing in on a false solution by searching the entire
acceptable thickness range to determine the thickness which gives the best possible match between
the measured and calculated spectra. The thickness range searched is determined by the initial guess
for thickness together with the thickness constraint. If no thickness is entered for an initial guess,
FILMeasure will search the entire thickness range from 0 to 100 microns. Since the time to find a
solution is proportional to the range of thicknesses being searched it is beneficial to provide an initial
guess for the thickness of the films to be measured.

Optical Constant (n and k) Measurement Details

Measurement of optical constants (refractive index and extinction coefficient, also called n and k)
requires a simultaneous determination of film thickness. The exception to this is for measurement of
a bare substrate. The approach used by FILMeasure to determine film thickness and optical
constants is the same as that used to measure thickness alone, except that now n and k are also varied
to optimize the match between calculated and measured reflectance spectra.

Since n and k vary as a function of wavelength, it is necessary to solve for them at every wavelength.
For a completely unknown material it is not possible to do this using a reflection spectrum only since
at each wavelength only one know parameter (reflectance) is known and there are two unknowns (n
and k). However, n and k are not independent, but are related to each other via what is known as the
Kramers-Kronig relation. If n were known at all wavelengths, k could be computed solely from n.
Since it is only possible to measure n over a finite wavelength range, k cannot be computed directly
from n.

In reality, however, there is plenty of data present from a single reflection spectrum to determine
both n and k simultaneously. This is due to the fact that the refractive index at any given wavelength
is not independent of the refractive index at adjacent wavelengths, but follows a smooth dependency
that can be accurately modeled by a theoretical equation. Furthermore, if there is an equation for
refractive index it can be transformed using the Kramers-Kronig relations to yield k. Thus, if the
equation for refractive index has three adjustable parameters it is only necessary to adjust these three
parameters, plus the thickness in order to match the calculated and measured spectra.
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Therefore, the measurement of n and k has been reduced to choosing an appropriate model for n and
k as a function of wavelength and then adjusting the parameters in the model to obtain a good fit to
the measured data. FILMeasure uses different models depending on the type of material being
measured.

The parameter space being searched to find a solution is potentially quite large since it involves
thickness plus the adjustable parameters of the model. Furthermore, since there are many near-
matches as the thickness in the model is varied, it is important to reduce the parameter space being
searched. This is done by homing in on the match closest to the initial guess. This will only be the
correct solution if the initial guess for thickness is within about ¥ wavelength of the correct value.
To permit more robust solution FILMeasure can search the entire constrained thickness range to
determine the correct thickness before it begins solving for n and k. This initial search feature is
enabled by checking one of the appropriate search mechanisms in the “Edit Structure” options dialog
box.

F20 Hardware Operation

The F20 performs two distinct functions: data acquisition and data analysis. Data analysis specifics
are discussed in Chapter 5. In this section we describe how the F20 acquires accurate spectral
reflectance data.

Light is supplied by a tungsten-halogen bulb that generates light from approximately 400 nm to 3000
nm. This light is delivered to and collected from the sample through a fiber-optic cable bundle and a
lens. The intensity of the reflected light is measured at 512 different wavelengths with a
spectrometer. The F20 spectrometer uses a diffraction grating to disperse the light and a linear
photodiode array to measure the light at the different wavelengths. The photodiode array operates by
integrating the current generated by light falling on each of the 512 pixels. After a user-selectable
integration time, the accumulated charge in each photodiode is read by the computer. Because a
longer integration time results in a larger charge, it is the integration time that determines the
sensitivity of the spectrometer. Adjustment of the integration time is used to obtain the proper signal
level. Too short an integration time results in a weak, noisy signal, while too long of an integration
time results in a saturated signal.

The Baseline Measurement

The baseline measurement allows the FILMeasure software to take into account the response
inherent to the F20 reflectance measurement hardware. It does this by measuring a reference sample
and by taking a *“dark” reading. In any optical system there are many components whose
characteristics vary with wavelength (e.g., the output of the light source and the sensitivity of the
spectrometer). However, when reflectance measurements are made, only variations in reflectance vs.
wavelength due to the sample under test are of interest. Therefore, FILMeasure must perform a
calibration to determine the spectral response of the system. This is done by making a measurement
of a "reference” sample that has known reflectance characteristics. Note that it is not necessary for
the reference sample to be the same as the substrate upon which films to be measured reside. The
only purpose served by the reference sample is to permit calibration of the optical system. For
example, it is possible to use a Si wafer as the reference sample and then measure films on GaAs,
InP, glass, plastic, etc.
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After the reference measurement is made a dark reading is taken. A non-zero dark level is due to
current leakage inherent to photodiodes, which causes each photodiode in the array slowly charges
up even when no light enters the spectrometer. Thus, in order to make an accurate measurement of
the light entering the spectrometer, it is necessary to subtract this "dark" current contribution. This is
the purpose of the "dark™ reading, which measures the magnitude of the dark current for a given
integration time. When a "dark" measurement is made, a spectrum is measured that represents the
signal generated by the spectrometer when a sample of zero reflectance is measured. To simulate a
sample with zero reflectance during a "dark™ measurement, a specularly reflecting sample can be held
at an angle with the light source turned on, or in many cases the light source may simply be turned
off momentarily during the dark measurement.

Due to drift in the light source and temperature of the spectrometer electronics, it is a good idea to
take a baseline periodically.
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AppendixD  Optional Features

D.1 Measuring Optoelectronic Devices

VCSEL cavity resonance dips and distributed Bragg reflectors (DBRs) may be measured by selecting
"Opto Values" from the "Measure:" list. To measure laser cavity resonance dips, select "Cavity Dips"
from the "Find:" list. This routine works by finding the wavelength that corresponds to the minimum
reflectance in a pre-determined wavelength range. The wavelength range that is searched can be
restricted in one of two ways, which are selectable in the Cavity Dip "Setup" dialog box. The
simplest way to restrict the wavelength range is to manually specify the range. The second is to
restrict the search to the range between the lowest wavelength above a given reflectance value and
the highest wavelength above a second (usually identical) reflectance value. The upper and lower
limits of the search are displayed on the screen, along with the cavity dip location.

The location of the center wavelength and the bounding reflectance minima of a DBR may be
measured by selecting "DBR Center" from the "Find:" list. The reflectance threshold for finding the
mirror minima can be specified with the DBR Center Setup box. This is especially useful when
measuring multiple and convoluted DBR structures.

D.2 Measuring Filters

The cut-off wavelengths of high-pass, low-pass, band-pass, and notch filters may be measured by
selecting "Filters" from the "Measure:" list. Filter measurements are made by taking appropriate
reference and dark readings as described in Section 6.1, and clicking on "Measure”. Measurement
parameters are set on the main screen. The wavelength range searched is restricted to that displayed
on the screen, which is determined by the "Graph Limits" dialog box, which is found under the
"Setup"” menu.
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Appendix E Light Bulb Replacement

A\ A\

Warning: Hazardous voltages are present within the unit. Never attempt any
maintenance without disconnecting the power cord.

Step by step:

1. Exit FILMeasure program and turn off your computer.

2.

A\ A\

Disconnect power cable from the F20/30/40/50, and the DB25 signal cable from the back

of the unit,

Disconnect fiber optic cables from the front of the unit.

Turn the unit over and remove the four recessed screws opening the two halves of the

enclosure.
VAN

Warning: Caution, avoid touching any interior components, other than the lamp, lamp base
and housing.

5.

6.

7.

Loosen lamp set screw (counter clockwise to loosen).

Insert new lamp fully into lamp housing. Do not touch the lamp glass.

Secure lamp with set screw (clockwise). Do not over tighten.

Plug new lamp into the lamp power connector. Do not test lamp with lid removed.

Replace the unit’s top cover and screws. Insert cord into wall supply and test light.
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Appendix F Automation and Data

Measurements can be automated and additional data analysis can be performed by user-supplied
software that communicates with FILMeasure via Dynamic Data Exchange (DDE). An example
program illustrating how to use DDE with FILMeasure is located in the “Client” folder, which is
inside the “FILMeasure” folder. Although the example program is written in Visual Basic, DDE-
based automation software can be written in any language that supports DDE. A single data entry is
linked and is used to return information from FILMeasure to the client application. Once the link is
set up, FILMeasure will also execute commands specified by the client application. To set up a link
to FILMeasure set up a DDE conversation as follows:

LinkTopic = "FILMeasure|FILMeasureDDE"
Linkltem = "DDESourceBox"

Although all commands are listed below, commands that refer to measurement options not included
with a particular system will not be available. For example, the commands dealing with OptoValues
measurements are only available in FILMeasure versions containing the “Measure: OptoValues”
option. The commands understood by FILMeasure are as follows:

ActiveSpectrometer(<arg>) — Sets the current active spectrometer used for data acquisition to
<arg>.

AnalyzelL ayer — Equivalent to pushing the thickness analyze button. This command can be useful for
testing DDE applications.

AnalyzeOpto — Equivalent to pushing the OptoValues analyze button. This command can be useful
for testing DDE applications.

CopySpectrum — Copies currently displayed spectrum onto the clipboard.
GetRMSError — Updates the linked data to be the RMSError resulting from the last measurement.

GetThickness(<arg>) — Updates the linked data to be the measured thickness of the layer specified
by <arg>.

MeasurelLayer — Equivalent to pushing the thickness Measure button. Updates the linked data to be
the measured thickness of layer 1 when finished measuring.

MeasureOpto — Equivalent to pushing the OptoValues Measure button. Updates the linked data to
be the measured position of DBR or FP parameter specified.

MeasureSpectrum - Equivalent to pushing the Spectrum Measure button. Copies measured
spectrum to the clipboard.
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OptoDBRThreshold(<argl>) — Sets the percentage threshold for DBR measurements to the value
specified by <argl>.

OptoDBRThresholdMode(<argl>) — use 0 in <argl> to specify percentage of absolute reflectivity,
use 1 to specify percentage of maximum reflectivity.

OptoFPMeasurementMode(<argl>) — use 0 in <argl> to specify measuring based on a percentage
of the maximum or absolute reflectivity, use 1 to specify measuring restricted by wavelength.

OptoFPReflectivityLimits(<argl>,<arg2>) — use <argl> and <arg2> to specify the lower and upper
reflectivity limits.

OptoFPReflectivity ThresholdMode(<argl>) — use 0 in <argl> to use the Absolute option, use 1 to
use the Maximum option.

OptoFPWavelengthLimits(<argl>,<arg2>) — used to set the lower and upper wavelength limits.
OptoMeasurementMode(<argl>) — use 0 to select cavity dip, use 1 to select DBR peak.
PasteSpectrum — Paste spectrum from clipboard and graph it.

PasteSpectrumRaw — Paste spectrum from clipboard, use reference and dark if selected, and graph
it.

SaveCalculation(<argl>) — Save calculated spectrum to file specified in <argl>.
SetintegrationTime(<argl>) — Sets the integration time to <arg1> milliseconds.
SetMat(<argl>,<arg2>) — Set material for layer <argl> to material <arg2>.
SetMatMedium(<argl>) — Set material for incident medium to material <argl>.
SetMatSubstrate(<argl>) — Set material for substrate to material <argl>.

SetNA(<argl>) — Set numerical aperture for measurement optics (only used in F40 systems).
SetStartWavelength(<argl>) — Set starting wavelength for data analysis to <argl>.

SetStructure(<argl>) — Set structure to <argl>. Note Argl must exactly match the name of an
existing structure in the list of structures. Valid structure names cannot contain parentheses.

SetStopWavelength(<argl>) — Set stop wavelength for data analysis to <argl>.

SetThickness(<argl>,<arg2>) — Sets the initial guess thickness of the layer specified by <argl> to
the thickness value specified by <arg2>. Updates the linked data to be the thickness value given in
<argz2>.

TakeDark — Take a dark measurement.

TakeReference — Take a reference measurement.
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